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Ce document commence par une traduction en français du manuel officiel Quick Start, qui 
fait office de chapitre « Démarrage », avec des améliorations de forme. Des précisions 
seront éventuellement ajoutées au fur et à mesure de l’utilisation   
 
A ce jour, le chapitre 2 ci-dessous « Utilisation avancée » n’est pas rédigé car il est couvert 
suffisamment par la traduction en français du manuel par un utilisateur qui le met à 
disposition sur le site Audiofanzine. 
 
De même le chapitre  3.1.1.1 ci-dessous sur le logiciel « BeatBuddy Manager » n’est pas 
rédigé tant que la traduction du manuel par un utilisateur couvre suffisamment le sujet 
(téléchargeable sur audiofanzine). Par contre le tutoriel officiel en anglais est traduit en 
français au paragraphe 3.1.1.2 ci-dessous. 
 
Les chapitres manquants seront éventuellement ajoutés si des précisions s’avèrent 
nécessaires au fur et à mesure de l’utilisation. 
 
Le chapitre 3.1 ci-dessous décrit des logiciels tiers qui facilitent la création de Rythmes MIDI. 
 
Enfin, le chapitre 4 ci-dessous donne les liens vers des informations sur internet : tutoriels 
vidéo et écrits etc… 
 

1 Démarrage 

 
Ce chapitre est une traduction du manuel Quick Start, avec des améliorations de forme ainsi 
que quelques ajouts : 
 

- Présentation issue du site internet 
- Quelques précisions, 
- Le post d’un utilisateur sur le forum BeatBuddy au paragraphe 1.3 ci-dessous 

« Ajouter un Song dans la carte SD ». 
 

1.1 Présentation 

 
La BeatBuddy est la première boite à rythme au format pédale qui permet au musicien de 
contrôler facilement le déroulé d’un Drum Beat au pied :  

- démarrer un morceau, 
- insérer des breaks, 
- lancer une transition d’un couplet à un chorus, 
- effectuer un break en arrêtant le morceau, 
- marquer un « Accent Hit » constitué d’un son de claquement de main ou d’un coup 

de cymbale et bien d’autres choses.  
 
Format des ressources  alimentant la BeatBuddy  
 
La BeatBuddy est basée sur le principe d’une boite à rythme MIDI. Les fichiers de rythmes 
des morceaux sont au format Midi, mais le BeatBuddy produit un son car c’est un source 
AUDIO. 
 
Les bibliothèques de son de batterie (Drum sets) de la BeatBuddy sont des bibliothèques de 
fichiers de son au format « .wav », enregistré à partir de batterie actuelle. Les fichiers Midi 
déclenche les fichiers « .wav » issus de ces bibliothèques. C’est pourquoi la BeatBuddy est 
capable de jouer n’importe quel rythme, avec n’importe quelle signature rythmique, en 



BeatBuddy - Aide mémoire            Janvier 2016 4/32 

utilisant des sons de batterie adaptés aux différents tempos pour produire un son 
complètement différent. 
 
Dans la plupart des cas, les bibliothèques de son de batterie et les rythmes ont été stockés 
au standard General MIDI Drum Map, ce qui fait que la majorité des morceaux peut être 
jouée en utilisant quasiment n’importe qu’elle bibliothèque de son (y compris sur un 
ordinateur). N’oubliez pas que tous les morceaux et les bibliothèques de son ne sonnent pas 
forcément bien ensemble : on peut obtenir des résultats étrange en jouant des rythmes jazzy 
avec des sons de batterie typés métal. 
 
Organisation des morceaux 
 
Les projets de la BeatBuddy sont organisés en morceaux (Songs), chaque morceau étant 
constitué de boucles (comme des couplets ou des refrains).  
Chaque morceau est constitué de :  
 

- une boucle principale, 
- un son associé aux accents 
- et plusieurs roulements de transition (Roll) qui lui sont associés. Quand on effectue 

une transition entre 2 parties d’un morceau, les parties sont jouées successivement 
jusqu’à ce que la dernière partie soit atteinte, 

 

1.2 Connexion 

 
Le beatbuddy produit son propre son, sans nécessiter d’autre équipement ; autrement dit 
c’est une source audio et non MIDI, et on peut écouter le son Drum Beat (Rythme) sur sa 
propre prise casque. 
 
Les prises Jack INPUT permettent de brancher sur la même sono à la fois le beatbuddy et 
un instrument (clavier par exemple) sans nécessiter de mixeur. 
 
Le beatbuddy étant particulièrement dédié aux guitaristes (mais pas seulement), si d'autres 
pédales sont branchées sur le BeatBuddy, celui-ci doit être après le lopper éventuel ainsi 
qu’après toute la chaine de pédales d’effets, de sorte que le son qu’il produit ne soit pas 
affecté par les effets, comme indiqué sur le schéma ci dessous. 
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Raccordement du Footswitch en option 

 
Le Footswitch n’est pas livré avec le BeatBuddy, bien qu’un footswitch soit nécessaire à son 
utilisation. 
 
Le constructeur recommande d'utiliser le footswitch officielle BeatBuddy (en option mais 
incluant le câble de connexion), conçu pour résister à une utilisation rude en live. 
 
Cependant BeatBuddy est compatible avec la norme Momentary/Latching Dual Footswitch 
disposant d’une connexion OUT (Jack) TRS (Stéréo) ¼ " (un commutateur est relié au canal 
de gauche et l’autre sur celui de droite). Les switchs ABY ne sont pas compatibles. 
 

 

Assurez-vous que le câble est branché à fond dans le 
Footswitch et le BeatBuddy. 
 
A la première utilisation du « Footswitch » configurer 
le beatbuddy comme suit : 
 
- 1. appuyer sur les boutons Drum Set et Tempo en 
même temps pour entrer dans le menu « Settings ».  
 
- 2. Sélectionnez « Footswitch > Footswitch 
Detector » et suivez les instructions.  

 
Le son du BeatBuddy est meilleur à travers une sonorisation complètement neutre sur toute 
la gamme des fréquences 
 
Beaucoup d'amplis de guitare et de basse produisent une gamme incomplète de fréquences 
(ils étouffent les hautes fréquences) et / ou produisent des distorsions qui altèrent la qualité 
du son du BeatBuddy. 
 
Par contre les Amplis de guitare acoustique, systèmes de sonorisation, et chaînes hi-fi ont 
tendance à être neutre sur toute la gamme de fréquence.  
 
Pour déterminer si le système de sonorisation altère la qualité du son du beatbuddy, faite 
l’écoute au casque branché sur le beatbuddy pour avoir une référence de ce que le son 
devrait donner sur la sono. 
 
Astuce pour l’utilisation avec une guitare et son ampli : Branchez le BeatBuddy sur la prise 
jack AUX éventuelle de l’ampli de guitare. 
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1.3 Utilisation basique 

1.3.1 Déclenchement des Parties, Transitions et Accents 

 
Définitions de la terminologie du BeatBuddy : Voir le paragraphe 3.1.2.1 ci-dessous 
 

 
 Insère un accent (Accent Hit) sous 

forme d’un son quelconque, qui peut 
être différent pour chaque partie de la 
chanson) 
Option *: tap tempo dédié 
 
* Les fonctions du Footswitch peuvent 
être changées dans le menu 
« Settings » en appuyant Drum Set et 
Tempo en même temps 

 
 
 
Commandes plus avancées 
 

- Appuyez sur la pédale une fois pendant le « outro Fill » ou la « Transition » pour 
annuler « l'outro » ou la « transition » et retourner à la partie de Song jouée. 

 
- Quand le Song est en pause: 

 
o Presser la pédale pour redémarrer le rythme avec un « Fill ». 

 
o Maintenez enfoncée la pédale pour arrêter le Song immédiatement sans 

« End Fill ». 
 

Lecture en cours : 
Interrompt/Reprend le 
rythme joué. 
 
Lecture à l’arrêt: Avance au 
Song suivant dans le dossier 

1
ère

 pression :  Démarre le rythme (avec 
l’éventuelle phrase « Intro Fill ». 
 
Pression simple :  Insére un « Fill » ou Break (en 
incrémentant le Fill à chaque fois, et après le dernier Fill 
disponible, retour au 1

er
) 

 
Pression maintenue :  Commence  une « Transition » 
 
Relâcher :  finit la « Transition » et avance 
à la prochaine partie du Song. 
 
Double pression :  Termine le Song (avec unz 
éventuelle phrase « Outro Fill ») 
 

Quand la lecture n’est pas en cours : Maintenir la 
pression pour entrer en mode tap tempo 
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1.3.2 Informations à l’écran et panneau de commande 

 

 
 
Indications de l’écran : 
 

- 1. Beat Indicator :  Indique la position du beat/temps dans la mesure 
- 2. Nom du Song 
- 3. Dossier où le Son est stocké 
- 4. Signature Rythmique du Beat 
- 5. Statuts de la lecture 
- 6. Drum Set actuellement sélectionné 
- 7. volume et tempo 

 
Commandes : 

- a. Potard Volume :  ajuste le volume, mais n’affecte pas le niveau de tout 
instrument branché sur le BeatBuddy 

 
- b. Potard Drum Set :  Modifie le set de batterie (sons) du rythme en cours de 

lecture. 
 

- c. Potard Tempo :  Modifie le tempo (vitesse) du ryhtme, mesuré en BPM 
(battements par minute). Appuyez pour entrer l’écran de sélection de Song.  

 
o Tourner le potard Tempo pour naviguer dans les Songs 
o Appuyer sur le potard tempo pour sélectionner le morceau. 
o Appuyer sur le potard Drum Set pour quitter à l'écran de sélection de dossier 

(où utiliser le potard Tempo pour faire défiler et sélectionner un dossier) et 
appuyer sur le potard Drum Set à nouveau pour retourner à l'écran d'accueil. 

 

- . Flèches   : Naviguer dans le menu de l'écran 
 

- . Flèches  :  Choisir un dossier/Song (flèche droite, ou le quitter 
(Flèche gauche) 
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- . Bouton  :  Pour passer en mode Tap Tempo, tapoter au tempo 
voulu sur le bouton ou la pédale, et le BeatBuddy calculera le tempo BPM 

 
- g. Headphones Volume : Contrôle le volume envoyé aux écouteurs (Le rythme et 

le son de l'instrument branché, le cas échéant) 
 

1.3.3 Carte SD 

 
Tout le contenu du BeatBuddy (Drum Beats, Drum Sets, Settings) est stocké sur la carte SD. 
La carte SD doit être correctement insérée dans le BeatBuddy, dans le bon sens et à fond. 
 
En cas de perte, le contenu par défaut de la carte SD est téléchargeable pour le  copier sur 
une nouvelle carte SD (http://mybeatbuddy.com/downloads/).  
 

1.3.4 Logiciel BeatBuddy Manager 

 

 
 
BeatBuddy Manager est téléchargeables sur http://mybeatbuddy.com/downloads/  
 
Le logiciel permet réorganiser le contenu par défaut du BeatBuddy, et surtout d’organiser le 
contenu téléchargé à partir de  http://mybeatbuddy.com/library/ ou de 
http://mybeatbuddy.com/forum/ le Forum utilisateur, ainsi que de créer vos propres 
ressources : 
 

- Songs à l’aide de fichiers General MIDI 
 

- Drum Sets à partir de fichiers WAV. 
 

http://mybeatbuddy.com/downloads/
http://mybeatbuddy.com/downloads/
http://mybeatbuddy.com/library/
http://mybeatbuddy.com/forum/
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Voir le manuel d’utilisation au paragraphe 3.1 ci-dessous. 
 

1.3.5 Télécharger de nouvelles ressources 

 
http://mybeatbuddy.com/library/ : Site de l’éditeur avec des librairies de « Drum Beats » 
MIDI et de « Drum Sets » Wav payants (5$ l’unité) 
 
Les packs de « Drum Beat » sont au nombre de 5, dont notamment 6 volumes  « The most 
popular cover songs of all times ».   
 

The most popular cover songs of all times 

VOL.1 VOL.2 VOL.3 
Brown Eyed Girl   Van Morrison 
Sweet home Alabama Lynyrd Skynyrd 
Rolling In The Deep Adele 
Hotel California   Eagles 
Wonderful tonight  Eric Clapton 
Take It Easy  Eagles 
Get Lucky  Daft Punk 
Born To Be Wild  Steppenwolf 
Superstition  Stevie Wonder 
Wonderwall  Oasis 

Locked Out Of Heaven Bruno Mars 
Crazy Little Thing Called Love     Queen 
Play That Funky Music Wild Cherry 
Sex on Fire  Kings of Leon 
Sweet Caroline  Neil Diamond 
Honky Tonk Woman Rolling Stones 
Wish You Were Here Pink Floyd 
Mustang Sally  Wilson Pickett 
Creep   Radiohead 
Tush   ZZ Top 

Use Somebody  Kings of Leon 
Smoke On The Water Deep Purple 
One   U2 
Proud Mary - Creedence Clearwater Revival 
Cocaine   Eric Clapton 
Summer Of ’69   Bryan Adams 
With Or Without You U2 
Ain’t No Sunshine  Bill Withers 
Come Together  Beatles 
Hard to Handle  The Black Crows 

VOL.4 VOL.5 VOL.6 
All Right Now Free 
Angels  Robbie Williams 
Bad Moon Rising  
 Creedence Clearwater Revival 
Happy  Pharrell Williams 
Have You Ever Seen The Rain ?   
 Creedence Clearwater Revival 
Heart Of Gold  Neil Young 
I Feel Good (I Got You)  James Brown 
I Saw Her Standing There The Beatles 
I Want You To Want Me Cheap Trick 
Imagine   John Lennon 

Johny B. Goode  Chuck Berry 
Lay Down Sally  Eric Clapton 
Let It Be   The Beatles 
Margaritaville  Jimmy Buffett 
Moondance  Van Morrison 
Peaceful Easy Feeling The Eagles 
Purple Rain  Prince 
Wanted Dead Or Alive Bon Jovi 
What’s Up?   4 Non Blondes 
You May Be Right Billy Joel 

Use Somebody  Kings of Leon 
Smoke On The Water Deep Purple 
One   U2 
Proud Mary  Creedence 
Clearwater Revival 
Cocaine   Eric Clapton 
Summer Of ’69   Bryan Adams 
With Or Without You U2 
Ain’t No Sunshine Bill Withers 
Come Together   Beatles 
Hard to Handle  The Black Crows 

 
http://mybeatbuddy.com/forum/  : Forum utilisateur. 
 

- Partagez le contenu que vous créez, 
- Découvrez le contenu partagé par les autres utilisateurs, et 
- Discutez des façons d'utiliser le BeatBuddy: 

 
BeatBuddy Tools 
 

- Forum  indépendant : (songs, Beats, kits, Tutoriels) 
 
http://groovemonkee.com/blogs/news/16906196-beatbuddy-midi-loops   
 

- Le site groovemonkee commercialise des boucles MIDI de Drum et de Bass, 
accompagnés de fichier XML de Drum Map qui assurent la compatibilité avec  
différents logiciels (GM, logiciels DAW, NI Abbey Road, EZDrummer, Addictive 
Drums, East West Ministry of Rock), au prix de 20$ pièce (22 volumes déjà édités à 
la date de décembre 2015). La compatibilité avec BeatBuddy est ajoutée 
progressivement sur les différents packs, au moyen de fichier BPM 
(BeatBuddyManager) et/ou de fichiers SNG (Song lisible par BeatBuddy). 
 

http://mididrumfiles.com/ 

http://mybeatbuddy.com/library/
http://mybeatbuddy.com/forum/
http://www.beatbuddytools.com/
http://groovemonkee.com/blogs/news/16906196-beatbuddy-midi-loops
http://mididrumfiles.com/
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- Le site commercialise des bouches de Drum (compatibilité avec BeatBuddy à 
déterminer), et propose aussi des boucles gratuites dans différents Styles. 

 

1.3.6 Dépannage et Support 

 
Si le BeatBuddy fonctionne anormalement, le débrancher pendant une minute, puis le 
rebrancher. 
 
Si cela ne fonctionne pas, les fichiers sur le Carte SD peut avoir été corrompus et vous 
pouvez les remplacer par les fichiers de sauvegarde téléchargeables sur : 
http://mybeatbuddy.com/downloads/. 
 
Support officiel par mail : support@myBeatBuddy.com 
 

1.4 Ajouter une Song dans la carte SD 

 
http://mybeatbuddy.com/forum/index.php?threads/add-new-songs-to-a-beatbuddy-sd-
card.1102/ 
 
Traduction d’un Post sur http://mybeatbuddy.com/forum . 
 

- 1. Insérez une carte SD ou SDHC dans l’ordinateur. Créer un contenu standard 
comme décrit dans « Creating a BeatBuddy SD Card from Standard Content». 

 
- 2. Sélectionnez « Import - Export -> Import Project from Pedal ». Le dernier 

emplacement est proposé, mais en répondant NON on peut aussi localiser la carte 
SD dans Windows Explorer. Sélectionner le dossier. 

 
- 3. BB Manager invite à entrer un nom de projet dans « BB Manager working directory 

workspace ». Pour travailler hors du Workspace du disque dur, donner un nom de 
fichier de projet (tels que "2014.bpp setlist"). BB gestionnaire copie des fichiers vers 
l'espace de travail. Il va importer les fichiers dans BB Manager de sorte que vous 
pouvez lire et éditer les fichiers. 

 
- 4. Pour lier le projet, dire oui, et BB Manager tiendra ce projet en synchronisation 

avec votre carte SD. 
 

- 5. Pour créer un nouveau dossier pour le Song, sélectionnez l'onglet « Songs », et 
sélectionnez « Organize > New folder ». Cliquez sur le nom « New Folder » pour lui 
donner un nom tel que « My Set List ». 

 
- 6. Ajouter de nouvelles chansons à « My Set List »  par « Import - Export -> Import 

Song ». Vous pouvez naviguer et sélectionner plusieurs chansons à importer. Vous 
pouvez maintenant lire et éditer les morceaux importés. 

 
- 7. Enregistrez le projet à tout moment en sélectionnant « File -> Save Project ». 

 
- 8. Synchronisez toutes les modifications sur votre carte SD par « Import - Export -> 

Synchronize Project ». Cela copiera les nouveaux fichiers dans la pédale et 
reconstruira les fichiers de configuration et d'index. 

 

http://mybeatbuddy.com/downloads/
support@myBeatBuddy.com
http://mybeatbuddy.com/forum/index.php?threads/add-new-songs-to-a-beatbuddy-sd-card.1102/
http://mybeatbuddy.com/forum/index.php?threads/add-new-songs-to-a-beatbuddy-sd-card.1102/
http://mybeatbuddy.com/forum
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2 Utilisation avancée 

 
Ce chapitre est couvert suffisamment par le manuel téléchargeable sur le site, et par sa 
traduction par un utilisateur, téléchargeable sur le site Audiofanzine (rubrique Médias). 
http://medias.audiofanzine.com/files/manuel-francais-beat-buddy-473245.pdf 
 
Un paragraphe est cependant ajouté 2.3.1 ci-dessous, en retranscrivant le tutoriel d’un 
utilisateur sur Audiofanzine. 
 

2.1 Panneau de commande (cf. paragraphe 1.2.2 ci-dessus) 

 

2.2 Manuel 

 
Traduction française par un utilisateur : http://medias.audiofanzine.com/files/manuel-francais-
beat-buddy-473245.pdf 
 

2.3 Truc et Astuces 

2.3.1 Créer un Song dans BeatBuddy Manager à partir d’un fichier MIDI Guitar Pro 

 
Tutoriel : Insérer une song sous BeatBuddy à partir .Mid 
Par francklechti le 27/10/2014 - (Tout public) 
 
Générer une song sous BeatBuddy Manager à partir d’un fichier au format Guitar pro ? 
 
Un descriptif rapide des actions à effectuer pour avoir un premier résultat. 
Je ne traite pas ici du cas du set de batterie, mais seulement de l’intégration de la trame du 
morceau sous le BeatBuddy manager à partir d’un fichier sous Guitar Pro. 
  

2.3.1.1 Etape 1 : 

 
(Nota : Cette étape n’est pas obligatoire, mais permets de travailler plus rapidement ensuite ) 
 

- Supprimer du morceau toutes les pistes sauf la piste de batterie. 
Sous GP6, dans la partie en bas à gauche, sélectionner la piste à supprimer, puis 
cliquer sur le symbole X : (j’ai pris ici pour exemple le morceau Powerslave d’Iron 
Maiden). 

 

http://medias.audiofanzine.com/files/manuel-francais-beat-buddy-473245.pdf
http://medias.audiofanzine.com/files/manuel-francais-beat-buddy-473245.pdf
http://medias.audiofanzine.com/files/manuel-francais-beat-buddy-473245.pdf
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Nota : Il faut faire l’opération pour chaque ligne, on ne peut pas sélectionner plusieurs 
pistes à la fois. 

  
Si on retourne sur la vue principale, on doit avoir quelque chose du style : 

 
 
Il faut maintenant découper la song en intro, riff principal, transition, etc…. 
 

2.3.1.2 Etape 2 : 

 
Générer un fragment MIDI, l’objectif étant d’extraire une partie du morceau au format Midi, 
pour le déposer ensuite dans le BBManager. 
 

- Découper ici l’intro, pour obtenir : (Nota : pour ma part, je préfère supprimer les 
mesures inutiles plutôt que de copier et de déposer dans un autre fichier) 

 

 
 

- sauvegarder ensuite ce fragment au format Midi : 
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J’ai sauvegardé ici ce fragment sous le nom powerslave-intro.mid 
  

- Faire de même avec le premier riff : 
o Découpage : 

 
 

o Puis sauvegarde 
 

2.3.1.3 Etape 3 : L’intégration dans BB Manager 
 
A partir d’un nouveau projet (dans lequel j’ai intégré la partie rock et la première song rock) : 
 
Pour intégrer la partie rock, j'ai ouvert le fichier config.csv (avec notepad) dans le sous 
répertoire SONGS de la copie des fichiers fournis sur la carte SD ( ou disponible sur le site 
web ) 
 
Ce fichier contient la liste des familles de songs : 

 
 

- recopier la ligne correspondant à la famille Rock dans le fichier .csv de mon projet 
vierge. 

 
- créer le répertoire 977B149C sous le répertoire SONGS. 

 
- Dans ce même répertoire, modifier le fichier config.csv, en lui ajoutant la ligne 

42ADB077.BBS,1. Rock 1 
 

- sauvegarder le fichier, et déposer également le fichier .BBS issus de la carte SD 
dans ce même répertoire. 

 
J'ai donc au moins un élément dans la famille. Manipulation pas indispensable, mais ça 
permet de comprendre l'arborescence des songs. 
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- Dans la partie droite, demander la création d’une nouvelle song : 

 
  

- nouveau bloc vierge s’affiche : 

 
 

- Attribuer maintenant un .mid à chaque partie. 
 

o Pour insérer l’intro, cliquer sur le bouton de chargement dédié :  

 
o la fenêtre de chargement de fichier s’ouvre, et choisir le fichier powerslave-

intro.midi. 
Après chargement, on a le rappel du nom du fichier midi : 

 
 

o l’écouter par un click sur l’icône de lecture. 
 

o Opération identique ensuite sur main loop, drum fill,, en fonction du 
découpage qu’on a choisi sur le morceau d’origine, pour finir par le outro fill. 
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-  mettre à jour le tempo : 
 

- choisir le set de batterie, 

-  préciser le titre de la song : 
  

2.3.1.4 Etape 4 : Sauvegarder le projet. 

 
On va alors avoir dans le répertoire du projet un nouveau fichier qui contient la song, et une 
nouvelle ligne dans le fichier de paramétrage au format excel  : 

 
 
  
Voilà, c’était la modeste contribution de Francklechti ! 
  
Pour rappel, et selon l'expression consacrée : 
  
Guitar Pro et BeatBuddy sont des marques déposées. 
Powerslave est un morceau écrit par Iron Maiden. 
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3 Logiciels de contrôle du BeatBuddy 

3.1 Logiciel PC et Mac 

3.1.1 BeatBuddy Manager 

 
Le logiciel et son manuel en anglais sont téléchargeables sur :  
http://mybeatbuddy.com/downloads/ 
 
Ce chapitre est couvert par ce manuel officiel dont une traduction en français par un 
utilisateur est disponible sur le site audiofanzine :  
http://medias.audiofanzine.com/files/beatbuddy-manager-manuel-francais-v1-40-473356.pdf 
 
De plus un tutoriel officiel en anglais, rédigé à l’occasion de la sortie de la version 1.5 est 
téléchargeable sur le site de l’éditeur au lien donné au paragraphe 4.2 ci-dessous. Une  
traduction en français est fournie dans le paragraphe 3.1.2 ci-dessous. 
 

3.1.1.1 Manuel de la version 1.4 

 
http://mybeatbuddy.com/downloads/ : Manuel officiel en anglais 
 
Traduction en français par un utilisateur disponible au lien suivant est retranscritet ci 
dessosus. 
http://medias.audiofanzine.com/files/beatbuddy-manager-manuel-francais-v1-40-473356.pdf  
 

3.1.1.2 Tutoriel de la version 1.5 (différence par rapport à la version 1.4) 

 
http://mybeatbuddy.com/forum/index.php?threads/tutorial-for-bbmanager-version-1-5-0.4301/ 
 
Ce tutoriel est ma traduction en français du tutoriel officiel en anglais, rédigé à l’occasion de 
la sortie de la version 1.5, et téléchargeable sur le site de l’éditeur au lien donné au 
paragraphe 4.2 ci-dessous. La forme est de plus condensée pour une meilleure lisibilité. 
 
Il existe une autre traduction mais d’une version provisoire du tutoriel ci-dessus 
http://fr.audiofanzine.com/bar/singular-sound/beatbuddy/pedago/tutoriels/les-modifications-
par-rapport-a-la-version-1-4-7212/ 
 
Création d'un projet : 
 

- 1) Insérez la carte SD dans votre ordinateur, ou placez la carte SD dans le 
BeatBuddy et le via USB à l’ordinateur pendant que le BeatBuddy est sous tension. 
(noter que sur les ordinateurs Mac, on peut uniquement insérer la carte SD 
directement dans l'ordinateur en attendant que le support USB soit disponible 
bientôt). 

 
- 2) Dans le Gestionnaire BeatBuddy, choisir « File > Open project » et choisir le 

lecteur qui contient la carte SD, qui pourrait s’afficher comme « disque amovible » ou 
quelque chose de similaire (sur Mac, ce serait « Volumes »). 

 

http://mybeatbuddy.com/downloads/
http://medias.audiofanzine.com/files/beatbuddy-manager-manuel-francais-v1-40-473356.pdf
http://mybeatbuddy.com/downloads/
http://medias.audiofanzine.com/files/beatbuddy-manager-manuel-francais-v1-40-473356.pdf
http://mybeatbuddy.com/forum/index.php?threads/tutorial-for-bbmanager-version-1-5-0.4301/
http://fr.audiofanzine.com/bar/singular-sound/beatbuddy/pedago/tutoriels/les-modifications-par-rapport-a-la-version-1-4-7212/
http://fr.audiofanzine.com/bar/singular-sound/beatbuddy/pedago/tutoriels/les-modifications-par-rapport-a-la-version-1-4-7212/
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- 3) Après le chargement du projet, il est automatiquement demander d’enregistrer une 
copie locale sur l’ordinateur. Après la fin de cet enregistrement (2-3 minutes), il est 
demandé si vous voulez « Save the project for future synchronizations »  (sauver le 
projet pour les synchronisations futures). choisissez «YES», car cela permettra de 
synchroniser les modifications apportées à la pédale. 

 
Deux choses à garder à l'esprit :  
 

- 1) Lorsque le user_lib ou default_lib répertoires sont appelés, les chemins complets 
sont : 
C: Users Nom d'utilisateur Documents BBWorkspace user_lib  
C: Users Nom d'utilisateur Documents BBWorkspace default_lib  

 
- 2) Lorsque le format Action 1> Action 2 - ce qui est toujours allusion au menu 

déroulant dans l'ordre dans lequel les options sont. Par exemple, « File > Export > 
Song » est: 

 
 

3.1.1.2.1 PARTIE 1 : Prise en main  

 
Définitions de la terminologie de BeatBuddy :  
 

- « Project » :  Combinaison en une seule entité sur votre carte SD, de 
« Song » et de « Drum Sets » (équivalent à « Drum Kits » pour d’autres instruments), 
ce qui représente, tout le contenu de la fenêtre ci-dessous :  
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« Folder » :   Le terme « Folder » utilisé dans le logiciel, désigne les dossiers affiché 
sur le côté gauche de la copie d’écran ci-dessus (dans lequel toutes les « Songs » sont 
stockées). 
Dans le manuel, le terme « répertoire » se réfère également à un dossier sur l’ordinateur (par 
exemple, lorsque nous parlons du dossier dans BBWorkspace) pour éviter toute confusion.  
 
En outre, la liste des « Songs » du dossier apparaît en déroulant le dossier sélectionné, par 
exemple:  

 
 
 
« Set List » :  Liste des « Songs » dans un dossier, qui peut être un « Set list » de 
morceaux personnalisés contenus dans un dossier personnalisé (par exemple, un nouveau 
dossier que vous avez créé avec juste les Songs dont vous avez besoin pour un concert 
spécifique).  
 
« Song » :  Piste individuelle de rythme qui contient AU MOINS  une « Loop » 
(boucle) de batterie principale. La majorité des Songs contiennent des boucles 
supplémentaires, soit plusieurs « Patterns »/ « Beats » (typiquement, « intro », « outro », 
« Fill », « Main Part »). Le terme « BBsong » peut également être utilisé comme synonyme 
pour éviter une ambigüité avec la signification courante deu terme anglais Song (chanson).  
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L'ensemble de la capture d'écran ci-dessous est un «Song»(BBsong) 

 
 
« Song Part » :   Représenté par une section horizontale complète sur la copie 
d’écran ci dessus. Chaque « Song Part » est affecté d’un numéro sur sa gauche 
représentant de passage, à part « l'intro » et « l'outro » qui sont affectés d’un « I » et d’un « 
O ». Voir la capture d'écran ci-dessus. Toute la section délimitée en rouge est un exemple 
« Song Part ». 
 
« Song Track » :  Chaque partie rectangulaire de la copie d’écran ci-dessous est 
une « Song Track » piste de morceau. Elles comprennent « intro », « outro », « Fill » (Break 
dans la terminologie d’autres instruments, « Transitions » (Roll),  « Accent Hit », et « Main 
Drum Loop ».  

 

 
 

3.1.1.2.1.1 Mise en route Feuille  

 
Vous pouvez accéder à ce résumé de feuille de calcul à tout moment dans le Gestionnaire 
BeatBuddy par « Help > Getting Started ». Une fenêtre contextuelle s’ouvre sans avoir à 
fermer votre projet.  
 
Remarque importante: Lorsque vous chargez d'abord un projet à partir de la carte SD, il vous 
sera demandé d'enregistrer une copie locale sur votre ordinateur. Après avoir 
l’enregistrement, il est demandé si vous voulez « link the project for synchronization » (lier le 
projet pour la synchronisation), comme indiqué dans l'image ci-dessous.  

 
 
Si vous avez l'intention d'appliquer les modifications que vous apportez au projet en cours à 
la carte SD (c-à-d à votre BeatBuddy), choisir «YES». On peut toujours changer plus tard par 
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une nouvelle liaison via « File > Export > Project to SD card » (ce qui écrasera le contenu de 
la carte SD avec le projet courant. Pour l'instant, choisissez «YES».  
 

3.1.1.2.1.2 Création de sauvegardes de vos projets  

 
Il est impératif de créer au moins une sauvegarde du projet, surtout si vous faites beaucoup 
de personnalisations. Une copie locale du projet peut être enregistrée sur l’ordinateur par 
mesure de sécurité.  
 
Il ya une autre façon de faire des sauvegardes des projets, en créant une version "zippée"  
de tous les projets dans un fichier unique, ce qui est une méthode à la fois rapide et 
sécuritaire (touts les projets sont sauvegardés dans leur version à un instant T). 
 
Voici comment faire :  
 

- 1.  « File > Save Project to » 
 

- 2. Une fenêtre d'invite apparaît, demandant où sauvegarder. Après avoir navigué à 
l'emplacement, et choisi un nom, sélectionner le Single File Project File (*.bbz) sous 
le menu « Save as type » (ci-dessous) 

 
 

3.1.1.2.2 PARTIE 2 : Maitrise de BEATBUDDY MANAGER 

 
Les sections précédentes couvrent les généralités du  tout le BEATBUDDY MANAGER.  
 
Cette section entre dans les détails.  
 
Personnalisations de base et « Set Lists » 
 
Par exemple pour la création d'une Set List pour un concert, créer un dossier personnalisé 
qui contient exactement les Songs et les paramètres que souhaités (BPM, Drum Sets, etc.). 
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- choisir 3 « Songs » de différents dossiers sur votre BeatBuddy, les placer dans un 
dossier dans un ordre spécifique. 

 
- modifier et enregistrer le BPM pour chaque « Song » ainsi qu’un « Drum Set ». 

Voyons voir comment faire cela avec une chanson. Le principe reste exactement le 
même pour les autres chansons que vous souhaitez importer dans ce nouveau 
dossier personnalisé. 

 

3.1.1.2.2.1 Créez une « Set List » en 4 étapes : 

 
- 1. Créer un nouveau dossier et nommer-le via « Songs > New Folder » 

 
 

Il se met automatiquement en haut de la liste des dossiers, et vous pouvez ajuster 
son emplacement (à savoir déplacer le dossier haut et en bas par rapport à d'autres 
dossiers). L’ordre dans la liste du BBManager sera l’ordre de succession dans le 
BeatBuddy. 

 
Vous pouvez renommer le dossier en cliquant à gauche. Par exemple  « Sat Nuit Gig 
». Il est actuellement vide et prêt à recevoir des Songs. 
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- 2. Choisir les « Songs » voulues, et les placer dans ce dossier. 
Sélectionner un Song. Choisir par exemple 'Blues' 1. Le Song est mis en évidence. 

 
 
Après, le choix du « Song » 2 actions sont nécessaire : Exportation de la chanson (à savoir 
l'enregistrer à un emplacement sur l'ordinateur par 'BBManager), puis Importer la chanson (à 
savoir l'importer dans le dossier voulu) : 
 

- « File > Export > Song » : la fenêtre d'invite doit automatiquement accéder à 
« user_lib\Songs » - Dans le cas contraire, accéder à ce dossier et sauvegarder le 
morceau. 
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Cliquer sur Save (Remarque: Vous pouvez enregistrer sous un nom différent sur 
votre ordinateur si vous le souhaitez, mais nous vous recommandons de conserver le 
nom pour l'instant) 

 
 
 

- Sélectionner le dossier voulu dans BBManager (en exportant 'Blues 1' vous étiez 
dans le dossier Blues). Il suffit donc de cliquer sur le dossier "Sam Nuit Gig» et 
assurez-vous qu'il est mis en évidence. 

 
 

- Importer la chanson que nous voulons dans ce dossier via File > Import > Song 
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- Sélectionner le Song voulu dans la fenêtre contextuelle. 

 
 
Note : 
Le processus décrit ci-dessus s’applique à tous les « Songs » voulus pour créer une « Set 
List ». Même si un Song voulu était déjà enregistrée auparavant sur l’ordinateur avec 
BBManager, il doit impérativement être importé depuis son emplacement actuel (l'exportation 
sert seulement à sauver une chanson avec BBManager sur l’ordinateur afin qu'il puisse être 
importé à nouveau). 
 

- Placer les « Songs » Hip Hop 1 et Marching 1 dans la Set List « Sat Nuit Gig », avant 
de réorganiser et d'éditer les Songs. 

 
- Une fois le Songs dans la « set list » « Sat Nuit Gig » dans l'ordre où ils apparaissent 

dans le dossier (les chansons les plus récentes importés apparaissent en haut de la 
liste, tout comme lorsque vous créez de nouveaux dossiers, ils sont au sommet de la 
liste des dossiers par défaut) - 
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- 3. Modifier quelques paramètres de ces Songs. 
o changer l'ordre en cliquant sur les flèches haut et bas encadrés en rouge - 

 
Par exemple dans l'ordre: Hip Hop 1, Marching 1, et 1 Blues (descendant).  

 
 

- 4. Synchroniser via la commande « File > Synchronize project » ! NE PAS OUBLIER  
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Rappelez-vous: 
o L'enregistrement de votre projet sauvegarde les modifications apportées au 

fichier de projet qui se trouve sur votre ordinateur, 
o la synchronisation applique ces changements au contenu de la carte SD. 

 
Bien que l’enregistrement du projet ne soit pas indispensable (sauf quand des 
modifications sont apportés aux Songs ou aux Drum Sets), il est TOURJOURS 
NECESSAIRE  de synchroniser pour que les modifications soient appliquées à votre 
carte SD. Cependant enregistrez votre projet SOUVENT, et synchroniser TOUJOURS 
avant de déconnecter la carte SD de l'ordinateur pour que les modifications apportées 
soient appliqués à la pédale. 

 

3.1.1.2.2.2 Définir le Tempo et le Drum Set pour chaque Song 

 
Avant d'apporter des changements réels aux Songs, tester un tempo et/ou un Drum Set, en 
utilisant la barre d'outils en haut de l'écran: 

 

 
 
Après avoir défini les paramètres à tester, appuyer sur le bouton « Play » pour commencer 
(ce qui jouera l'intro, puis la première boucle principale jusqu'à ce que «Stop» soit pressé), 
afin de juger de l’effet en temps réel sur la performance en manipulant virtuellement la 
BeatBuddy sur son image à gauche. 
 

- appuyer sur la pédale principale pour lancer la chanson,  
- presser à nouveau pour lancer un « Fill », 
- maintenez la transition,  
- et double tap à la fin;  

 
- le bouton de gauche permet également de jouer une Accent de la partie actuelle du 

Song, afin de tout tester comme dans une situation live. 
 



BeatBuddy - Aide mémoire            Janvier 2016 27/32 

 
 
 
Après avoir décidé du tempo et du Drum Set souhaité par défaut, faire les changements 
réels. 
 
 

- Changer le « tempo » par défaut 

 
 

- Changement du « Drum Set » par défaut 

 
 
Vous pouvez même changer le nom du « Song » qui apparaîtra sur l'écran de votre 
BeatBuddy! 
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** Et souvenez-vous toujours de synchroniser (« File >  Synchronize Projec ») !!! 
 

3.1.2 BeatBuddy Midi Editor (A trouver) 

 
Un logiciel du nom de « BeatBuddy Midi Editor » est introuvable sur le net. 
 
Il reset à déterminer s’il est installé en même temps que « BeatBuddy Midi Manger » ou s’il 
s’agit d’un logiciel tiers (peut être « BeatBuuilder » décrit au paragraphe 3.1.3 ci-dessous). 
 

3.1.2.1 Manuel (A rédiger) 

 

3.1.2.2 Créer ses propres Songs et Drum Set : Post  

 
http://fr.audiofanzine.com/bar/singular-sound/beatbuddy/forums/t.608723,faire-ses-propres-
morceaux-et-ses-propres-sons-facile.html 
 
En gros, pour faire son propre morceau, le « BeatBuddy Midi Editor » est simplissime pour 
pondre des patterns simples, que l'on enregistre et récupère dans le « BeatBuddy Manager » 
pour les organiser et leur affecter un nom et un « Drum Set » (les sons) de base. Puis on 
synchronise le tout (un clic), on glisse la SD Card dans la BB et c'est tout... difficile de faire 
plus simple. 
 
Pour faire son propre set de sons, pas plus difficile : on enregistre ses sons en .WAV ou on 
les récupère sur le net, et on les affecte sons par sons aux bons instruments dans le BB 
Manager, on sauvegarde et on synchronise... enfantin ! 
 
Le BB Manager est puissant mais facile à utiliser. Il y a 2 ou 3 concepts qu'il faut saisir, 
comme le coup des samples différents suivant la vélocité de jeu, ou suivant le hasard (tantôt 
l'un, tantôt l'autre) pour mieux groover, donc une petite lecture de la doc peut être 
intéressante, mais franchement c'est ultra facile. 
 
Je regrette toutefois que « BeatBuddy Midi Editor » ne soit pas intégré DANS le « BB 
Manager », car c'est un peu relou de devoir exporter de l'un pour importer dans l'autre 
10.000 fois, par exemple pour régler finement le volume des différents instruments d'un 
même set les uns par rapport aux autres en jouant sur la vélocité. 
 
Petite astuce : si vous téléchargez un jeu de sons samplés d'une batterie qui vous plait sur le 
net mais que vous voulez l'adapter un peu à votre besoin (un peu plus de reverb, une equa 
un peu différente...) alors un petit passage des différents sons dans Audacity (gratos) vous 

http://fr.audiofanzine.com/bar/singular-sound/beatbuddy/forums/t.608723,faire-ses-propres-morceaux-et-ses-propres-sons-facile.html
http://fr.audiofanzine.com/bar/singular-sound/beatbuddy/forums/t.608723,faire-ses-propres-morceaux-et-ses-propres-sons-facile.html


BeatBuddy - Aide mémoire            Janvier 2016 29/32 

fera ça en quelques instants et facilement, avant de les injecter dans le BB Manager puis 
dans la BB elle-même. 
 

3.1.3 BeatBuilder 

 
http://mybeatbuddy.com/forum/index.php?threads/free-midi-editor-designed-for-
beatbuddy.2545/ 
 
Fichier Java (.jar) exécutable sans installation (à condition que Java soit déjà installé). 
 
C’est est un créateur de piste de batterie et un éditeur spécialement conçu pour une 
utilisation avec la pédale BeatBuddy et le logiciel « BeatBuddy Manager ».  
 
Les fonctionnalités comprennent : 
 

- réglages de volume, 
- « humanisation » automatique des patterns de batterie grâce à la randomisation des 

volumes et la déquantification de notes, 
-  fonctions d’un l'éditeur standard : couper, copier, coller, supprimer, et insérer. 

 
« Beatbuilder » automatise la conversion des fichiers MIDI téléchargés dans un format 
compatible avec la pédale BeatBuddy. Plus précisément, il reconfigure les instruments vers 
un sous-ensemble d’instruments inclus dans les kits BeatBuddy standard. Il permet 
également de sélectionner des morceaux d'un fichier et de les enregistrer en tant que parties 
de la chanson et permet de juger si les événements de note sont pertinentes dans la piste, 
ce qui rend plus facile de travailler avec la limite de note de 500. 
 
Télécharger le fichier « BeatBuilder.jar » sur le disque dur (et créer éventuellement un 
raccourci dans le menu et/ou sur le bureau) : 
https://www.dropbox.com/s/rm4weqraqw4ye2t/BeatBuilder.jar?dl=0  
 
En premier lieu, le PC / Mac doit avoir Java 1.7 ou supérieur installé. Si besoin, le 
téléchargement est disponible sur : http://java.com/en/download/  
 
Pour les utilisateurs de PC, il suffit de double-cliquer sur le fichier jar pour l'exécuter. 
 
Les utilisateurs de Mac doivent effectuer les étapes suivantes pour rendre le fichier 
excutable : 

- 1. Cliquet une fois sur le fichier .jar dans le Finder. 
- 2. Dans la barre de menus du Finder, sélectionner « Fichier > Lire les informations ». 
- 3 Cliquez sur «Ouvrir avec » et dans le menu contextuel. 
- 4. Sélectionnez « Jar Launcher », qui est intégré dans OS X. 
- 5. Double-cliquez sur le fichier .jar du programme pour le lancer 

 

http://mybeatbuddy.com/forum/index.php?threads/free-midi-editor-designed-for-beatbuddy.2545/
http://mybeatbuddy.com/forum/index.php?threads/free-midi-editor-designed-for-beatbuddy.2545/
https://www.dropbox.com/s/rm4weqraqw4ye2t/BeatBuilder.jar?dl=0
http://java.com/en/download/
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Pour ceux qui ont déjà téléchargé une copie bêta et essayé, il est suggèré de vérifier la boîte 
de dialogue d'aide, qui affiche quelques trucs et astuces. 
 

3.2 Application tablette 

 
Il n’existe pas à ce jour d’application tablette dédiée au BeatBuddy, que ce soit pour iOS ou 
Android. 
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4 Informations sur Internet 

4.1 Tutoriels vidéos 

 
Le commentaire audio de tous ces tutoriels est en anglais. 
 
Le site de beatBuddy http://mybeatbuddy.com/library/tutorials contient 4 des tutoriels listés 
ci-dessous, mais beatBuddy en met d’autres à disposition sur sa chaine youtube, et  certains 
sont dus à des utilisateurs. 
 

 BeatBuddy - Overview 

 BeatBuddy Live Performance Partner 

 BeatBuddy Learn New Musical Styles 

 How to install the BeatBuddy manager software (officiel) 

 The original BeatBuddy manager tutorial (officiel) 

 How to import new songs/Drum Beat into the BeatBuddy (officiel) 

 How to import a new drum set into BeatBuddy (officiel) 

 How to update BeatBuddy firmware (officiel) 

 Tutorial 1 - Installing the Beatbuddy manager software 1.32 on Win7 

 Tutorial 2 - Using the Beatbuddy manager software 1.32 

 Tutorial 3 - How to edit an existing Beatbuddy Song (not midi) 

 Drum Set Editor Tutorial 1 - General Overview 

 Drum Set Editor Tutorial 2 - Modifying Kits and creating copies 

 Drum Set Editor Tutorial 3 - Installing user kits & Creating kits 
 

4.2 Tutoriels écrits 

4.2.1 Tutorial for BBManager version 1.5 

 
Ce tutorial en anglais couvre la version 1.5 du logiciel BeatBuddy Manager dont le manuel 
n’existe à ce jour que pour la version 1.4. 
http://mybeatbuddy.com/forum/index.php?threads/tutorial-for-bbmanager-version-1-5-0.4301/ 
 
Une traduction en français en est fournie au paragraphe 3.1.2 ci-dessus. 
 

4.2.2 Traduction par un utilisateur de la version PROVISOIRE du tutoriel ci dessus 

 
http://fr.audiofanzine.com/bar/singular-sound/beatbuddy/pedago/tutoriels/les-modifications-
par-rapport-a-la-version-1-4-7212/  
 
 

http://mybeatbuddy.com/library/tutorials
https://www.youtube.com/user/MyBeatBuddy/videos
https://www.youtube.com/watch?v=OUWG9LmaCcs
https://www.youtube.com/watch?v=ooHOLQSMM3I
https://www.youtube.com/watch?v=EoWPbeKqTiI
http://youtu.be/8l-w6TO1l9c
https://youtu.be/YwklAiYmeoY
https://youtu.be/sIX1R-wRmfs
https://www.youtube.com/watch?v=J-u9x4oe27U
https://youtu.be/0O7I0jtlXkA
https://www.youtube.com/watch?v=jUEC2J-1Qfo
https://www.youtube.com/watch?v=XZyN9gNk0w4
https://www.youtube.com/watch?v=TAsDOEo_Vtw&feature=youtu.be
http://youtu.be/CUL_zAVWK7g
http://youtu.be/VyvSlDYRsRU
http://youtu.be/dRB7u8ufM10
http://mybeatbuddy.com/forum/index.php?threads/tutorial-for-bbmanager-version-1-5-0.4301/
http://fr.audiofanzine.com/bar/singular-sound/beatbuddy/pedago/tutoriels/les-modifications-par-rapport-a-la-version-1-4-7212/
http://fr.audiofanzine.com/bar/singular-sound/beatbuddy/pedago/tutoriels/les-modifications-par-rapport-a-la-version-1-4-7212/
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